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Access Forms and Reports

Overview

Forms and reports can be used to simplify data entry, editing, or viewing printed information. Both forms and reports display data derived from an underlying query or table. Forms are primarily for viewing/editing data on screen while reports are designed to present information in a printed format. Beginning with a form or report wizard can generally save time and effort in creating your form or report. 
Both forms and reports can incorporate text, pictures, lines, and various other types of controls. While using a wizard can greatly simplify the creation of a form or report, you may wish to add controls that are only available via Design View.
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To build an AutoForm, click Forms, New and select AutoForm (Columnar, Tabular or Datasheet), select a table or query, and click OK. Or select a table or query and click on the AutoForm button on the toolbar. If this table has a one-to-many relationship with one or more other tables, those tables will appear as subforms.

Form Wizard

[image: image10.png]Another easy way to get started with forms is to use a wizard. To create a form with the wizard, click on Forms, New, and select Form Wizard. 
1. Select the table or query to use in the form.
2. Select the fields to display in the form.
3. To create a subform, you may choose to add fields from another table or query. From this screen, select the second table or query from the drop-down list and add desired fields before clicking Next. 
4. Choose a layout (e.g., Columnar or Tabular)
5. Choose a style for the form (font, colors and background image).
6. Name the form and click Finish.
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Form Views 
The most frequently used views of a form are Design View, Form View, and Datasheet View. Any customization of the form’s appearance or characteristics will have to be done through the Design View. 
Controls

Every object on a form or report is a control and has its own set of properties (displayed in the Property list) that determines the characteristics of the data it contains. Some controls are linked to fields in the underlying table or query and some are merely text or graphical objects not related to any data source. Two of the most commonly used controls in a form or report are labels and text boxes. 
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Label: Displays unchanging or informational text often times as headings or titles. Labels do not come from a source in the database such as a field or expression. This is called an unbound control because it is not bound to any data source.
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Text Box: Displays data as text and is a bound control. A bound control displays information that is stored in a field from the data. Text boxes are used to display, enter, and update values from fields in your database. 
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Toolbox

The Toolbox toolbar should display by default in Design View. If it does not appear, from the menu choose View, Toolbox. This displays most of the controls or objects you can add to a Form/Report. For more information about a toolbox button, click on the button and press F1. To create one of the controls from the toolbox, click the buttons to select it and use your mouse to drag and draw the control in the Design grid.
Note: Because reports present data in a printed format (or print preview), not all controls will function in a report. For example, a combo box is a form control and while you can add one to a report, it will not display any data. Similarly, placing a command button on a report will not work because a report is either sent to the printer or displayed in Print Preview mode. There is no direct interaction with a report. 
Form Sections

Forms consist of header, footer, and detail sections. In forms, there are two types of headers/footers. Form headers and footers are visible on every page of the form. Page headers/footers only appear on a printed copy of a form. There are never visible in Form View. Information about individual records appears in the detail sections. 
New forms contain only a detail section by default. To delete or add a section, go to the menu and choose View, Form Header/Footer or View, Page Header/Footer. These sections can be turned off with the same menu.
Sizing Sections 
Adjust the size of the area for any of the sections (headers, footers, detail), by dragging the horizontal border for that section with your mouse. To adjust line spacing in the detail section, drag the Detail border. There is no other line spacing option.
Selecting and Editing Controls

All actions you can perform on a control, including moving, sizing, changing properties, or deleting it, require that you select it first. Make sure the selection tool (arrow) is activated before clicking on a control. 
Select one control – click once on it. Handles will be displayed around the object.


Select multiple controls – hold down the Shift key while you click each control.
Select a form or report – click the upper left corner of the form or report or press Ctrl+R.
Select a section – click on the gray bar above the section to select it.
You can also select multiple controls by using the mouse to drag an outline around them or by dragging the mouse through the horizontal or vertical ruler bar. 
Format Toolbar

[image: image15.bmp]Use the Format Toolbar to change fonts, colors, alignment, appearance, etc. of any single control or group of controls. Select the control(s) or section bar of the area to format, and choose the appropriate button from the Toolbar.
[image: image16.bmp]Sizing Controls

To size a control, first select it by clicking on it. This adds sizing handles to the control. To size a box, drag any of the sizing handles located on the border around the control. To "size to fit" a control or label, double-click on any of its sizing handles. 
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Moving Controls

Move a control and its label at the same time by dragging them with the “full-hand” icon. To move them separately do so by dragging the upper left hand box only. 
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Format Options

There are tools available on the Format menu to help you size, align and space the controls on a form or report. Generally, if you wish to both Size and Align controls, you should size them first, then align them. 
With both Size and Align you first select a control that is the correct size or alignment, then size other controls accordingly. 
Deleting Controls

To delete a control, click on it once to select it then press the DEL key on the keyboard.
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Cut/Copy/Paste 
To cut or copy a control, select the control and choose either Cut or Copy. To paste the control at the top of a different section, click on that Section’s header bar and choose Paste. To paste the control directly underneath another, select the control under which you wish to paste and choose Paste.
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Adding Fields 

To display the field list, open the form in Design view. From the View menu choose Field List or click the Field List button on the toolbar. You can add one or more fields at a time. To add one field, drag the field name to the design grid. To add all fields, double click on the field list title bar and drag all fields as a group. To add multiple fields, CTRL-click on the fields you wish to add to select them, and then drag as a group to the grid. When you choose a field from the field list, Access also creates a label from the field name.
Toolbox 
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Select Tool
This button should always be depressed unless you wish to create one of the other controls listed below. 
Control Wizard Button [image: image2.bmp]
When this button is pressed, a Control Wizard will help you create a new option group, combo box, list box, or command button. To use the Wizard, depress the Wizard button, and click the button to create the desired control. The appropriate Wizard will appear to step you through the process.
Graphics [image: image3.bmp]
Add a graphic file by clicking the image button and sizing an image frame. Once you have sized the frame, you will select the name of the image file to display. Set the Size Mode and Picture Alignment properties for the image if it does not display properly. 
Menu Boxes [image: image4.png]



There are two kinds of drop-down menu boxes. These boxes present drop-down lists containing values from an existing table or query or from a list you specify. A list box requires that you select an item from the list. With a combo box, you can either type a value in the box or select from the list. If you want Access to select the closest matching entry when you type a few leading characters in a combo box, set the Auto Expand property to Yes.
Command Button [image: image5.bmp]
Use a command button to create a button that when clicked will activate a macro or Visual Basic for Applications (VBA) procedure. 

To simplify the database for the users so they see the most commonly used forms and reports in your database, you can create a form with command buttons, like the Main Switchboard in the Northwind database. Using the Command Button Wizard, select the Open Form or Preview Report action, select the form or report you wish to open, and type in the text for the button.
Properties [image: image6.png]
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Each form, report, section, and control has property settings that you can change to alter the look or behavior of that particular item. Use the properties sheet to view and change properties. There are five tabs:

1. The Format tab displays properties that determine the item's appearance.

2. The Data tab determines how the item interacts with the data in the database, e.g. the source of the item's data.

3. The Event tab determines how events attached to the control are handled, e.g. when a button is clicked.

4. The Other tab contains miscellaneous properties.

5. The All tab lists all the properties on a single tab.
How to set properties
1. In Design view, select the control, section, form, or report for which you want to set the property.
2. Display the property sheet by right‑clicking the object or section and then clicking Properties on the shortcut menu, or by clicking the Properties button on the toolbar.
Note: To learn more about any property, click in its box and press F1 for context-sensitive help.
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How to add a background image to a form or report
1. Open the form or report in Design View.

2. Open the property sheet for the form or report. 

3. Enter the path and filename for the picture in the Picture Property. (Click the … button to browse for the file.)
4. Set the picture's properties as shown in the diagram.

Some properties in the data tab:

Control Source: The field or expression that provides the data for a text box control. 
Record source: Table or query that provides the data for a form or report. 
Allow Edits: If this property is set to No, it means that existing data cannot be modified. This property has no impact on new records.
Allow Deletions: If you want to make sure that users can't remove a record from the table, set this property to No.
Allow Additions: If you want to use a form for only editing or deleting data, then set this property to No. 
Data Entry: Change this property if you want to set the form for data entry only. Setting the property to yes means the form will always display as a blank data entry form.
Default Value: This property is the same as a table's property. Enter a code, e.g., Date() or text as the default value of a control.
Pivot Tables 
[image: image24.bmp]A pivot table summarizes data using combinations of fields for rows, columns and pages. A pivot table is often used for numeric data that depends on three or more variables.
1. Click Forms, New, and either AutoForm: PivotTable or Pivot Table Wizard. 
2. Select the table or query that contains your data and click OK.

3. If necessary, select a name for the pivot table and click Finish.

4. Drag the numeric field to the Data position.

5. Drag any of the other variables to row, column or page positions to view the data in different ways.

Access pivot tables are similar to Excel pivot tables, for which a CTSS class handout is at

http://www.ctss.colostate.edu/class_handouts/Excel%20Adv2.pdf.
Chart Wizard

With the chart wizard, you can create a 2- or 3-dimensional chart based on a table or query. 
1. [image: image25.png]| Frsthame  « | MsSansserf |8




Click Forms, New, Chart Wizard.

2. Select a table or query and click OK.

3. Select the fields to be included in the chart.

4. Select the type of chart (column, line, area, pie, etc.).

5. Drag the fields to the axes where you want them to appear.

6. Type a title for the chart.

7. Decide whether to display a legend.
8. Click Finish to view the chart.

9. Switch to Design View.

10. Adjust the size of the chart to fit the window, if desired.

11. Double-click the chart to edit it (using Microsoft Graph). The datasheet and Data and Chart menus will appear, and chart formatting buttons will appear on the toolbars.

12. Right-click any element such as the title or axes, click format, and make formatting changes.
Access charts are similar to Excel charts, for which a CTSS class handout is available at

http://www.ctss.colostate.edu/class_handouts/ExcelChart.pdf.
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Creating New Reports

There are three methods for creating new reports:
· Select a query or table and click on the AutoReport button to create an "instant" report. 
· Use the Report Wizard to choose the fields you wish to display and select a report style. 
· Go directly to Design View and create the report from "scratch". 
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Mailing Labels

Mailing labels may be generated from any table or query. To create labels, 
1. Choose Reports, New, Label Wizard. 
2. Choose the size of label and add the fields from the data source. Click Finish.
3. Save the label format. It is saved as a report. 
Note: If you can’t find the label size you need, you can create a custom label report by clicking on the Customize button in the Label Wizard.
[image: image28.png]Grouping Intervals

Wht arouping ntervals do you want for group-ievel fekds?

Group-evel fields: Grouping ntervals:

ok

Jliomal

13t Letter
2 Intial Lotters
5 Intial Lotters
4 Intial Lotters
5 Initial Letters.

Perartmertiare

Cancel




Using the Report Wizard

It is generally easiest to use the Report Wizard to start your report. In most cases, you will probably need to use the Design View to refine the design. To create a new report, click on Reports, New, and select the Report Wizard. 
1. Select the table or query that contains the data for the report. 
Note: If you need fields from more than one table, it is generally more efficient to make a query first and use that as the data source for the report.
2. Select the fields you wish to use.
3. If you wish to add fields from another table or query, select the second table or query from the drop-down list on this screen and add those fields before moving on to Next. 
4. Repeat the steps to select a table or query, and pick fields that you want to include in the report, until you have selected all the required fields.
Grouping Levels
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After selecting the tables/queries to display in your report and the fields you wish to use, you may want to add Grouping Levels. A Grouping Level allows you to group records by any field in the data source. You can either choose to group items according to an entire entry within a field (choose normal) or by the first several characters of a field’s entry (pick the desired number of characters). The Group Interval options are available by clicking on the Grouping Options button.
Report Sections

Reports consist of header, footer, and detail sections. You will find that there can be several different types of header and footer sections. Information about individual records appears in the detail section. 
New reports contain a page header and footer section. You can add a report header and footer by choosing View, Report Header/Footer. Headers and footers come together. Therefore if you want the page headers only (and not the page footer), you will need to drag the border of the page footer section until it has no height. Note: You cannot delete a section if there are controls in that section. 
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Sorting Reports

In reports you can sort and group data according to fields you specify. (This feature is not available in forms.) You can choose to sort only or, additionally, divide the data into groups. Choose Sorting and Grouping from the View menu. You can choose to sort up to ten fields.
Conditional Formatting
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You can apply a specific type of formatting to a control such as color, font, etc. when a certain condition of your own specification is met. To apply a conditional format, from Design view, select the control to which the conditional formatting is to be applied, and click on Format, Conditional Format. Select the appropriate condition, enter an expression if needed, and select the formats to be applied when the condition is met.
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